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DECLARATION OF CONFORMITY 
EBS Ltd. Co. hereby declares that mentioned PX100D product conforms 
to all the applicable requirements of EU and Council Directive 

No.1999/5/EC of 9 March 1999. A copy of Conformity Declaration is 
available at: http://www.ebs.pl/certyfikaty/ 

 
This crossed out dustbin symbol indicates that when the last user wishes 
to discard the product at the territory of European Union, it shall be 

utilized at an authorized and approved collection point. It applies both to 
the device and accessories marked with this symbol. Do not discard these 

products along with unsorted municipal wastes. 
 

The content of this document is presented as “it is”. The manufacturer does not 

grant any guarantee both expressed or implied, including but not limited to any 
understood guaranties in respect of merchantability and any warranty of fitness for 

a particular purpose, unless required with effective legal provisions. The 
manufacturer reserves the right to amend this document, or withdraw it any time 
without prior notice. 

 
Policy of the device manufacturer is to constantly develop the product. The 

manufacturer reserves the right to make modifications and changes without prior 
notice in respect of any model functions described in this document. 

 
Depending on programming of devices there are varied available functions. Further 
details available at Distributor of devices. 

 
Under any circumstances the Manufacturer shall not bear responsibility for any data 

or income loss, or any other peculiar, accidental or indirect damages caused in any 
way. 
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1 INTRODUCTION 
 

EX20 module is purposed for transmitting alarm signals from facilities using 
Ethernet-Internet network 

The transmitters are characterized with great programming flexibility, facilitating 
use in systems with specific requirements, as well as a number of unique solutions 
absent in other transmitters of this standard. 
 The great advantages of the transmitters are the remote configuration option, as 
well as firmware update using dedicated software. 

 
2 FUNCTIONAL AND TECHNICAL PARAMETERS 
 

− 4 NO/NC       

− DTMF 
− RS-232 

Inputs: 

(programmable) 

Sabotage - 1 NO/NC  

Outputs: 

(programmable) 

Sabotage - 1 

Additional - 1 

Data transmission ETHERNET 

(IEE 802.3; 10Mbps/100Mbps; DHCP/Static IP; LAN/WAN) 

Configuration: - Remote  

- Local  

Security: AES encoding 

Loading of AUX 
and SAB outputs 

100 mA 

 
In dependence from user's decision "Transmitter EX20” can be delivered in different 

versions. Therefore also the parameters as type of the power supply voltage, 
current consumption as well as the dimensions were introduced for following 

options separately: 
 

Option 1 - Transmitter EX10 + power supply LX-ZAS in metal box  
Option 2 – Transmitter EX20 
 

 Option 1 Option 2 

Voltage type 230 VAC 

(190 – 250 VAC) 
50 – 60 Hz 

type 13.8 VDC 

(12 – 14 VDC) 

Current/Power 
consumption 
(average/max) 

4 W / 20 W 
@230 VAC 

140 mA  
@13.8 VDC 

Dimensions 502 x 502 x 88 
mm 

(metal box) 

102 x 73 x 35 mm 
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3 ASSEMBLY AND WIRING 
 
Transmitter is delivered along with a power supply (See below). The 
manufacturer provides necessary wiring linking a power supply with the 

transmitter, and described procedures relate to wiring of a transmitter printed 
circuit board. 

 
Switch power off to perform any connection. 
 

3.1 SCHEME OF CONNECTIONS 

 

 

 
 

Figure 1. EX10 Transmitter with LX-ZAS 
 

 
a) Connections of wires shall be made with due care to prevent any faults 

or dead shorts. Places of connections shall be protected against weather 
conditions.  

b) According to the above figure terminals of transmitter shall be 

connected to: 

AKUMULATOR 
(ACCUMULATOR)

-   + 

BIAŁY (WHITE)

ZIELONY (GREEN)  

CZERWONY (RED) 
BRĄZOWY (BROWN) 

230V 
230V 

18V    0V

TRANSFORMATOR 
(TRANSFORMER) 

220V~

OBUDOWA (HOUSING) 
TAMPER 

LXZS 
EX20 

LINIA 
TELEFONICZNA 
(PHONE LINE)  

CENTRALA 
ALARMOWA  

(CONTROL PANEL)

DTMF  

 

ETHERNET 

Programming cale  
LX-PROG or Data 

transmission cableLX-DATA  
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Terminal Connection description. 

RING-TIP Terminals for an PSTN telephone line 
  

T1 – R1 Connection to alarm control panel phone communicator 
  

COM Device ground, common for other input and output 

  
T Connection of monitoring sabotage switch (the second switch 

contact connected to COM terminal). 
  

IN1 till IN4 Signal inputs. Possible connection of detectors contacts or 

alarm control panel outputs. COM terminal is common for all 
inputs. 

  
TMP Sabotage output indication output type OC. It may control 

external device. Provides ground during activation. 

  
AUX Type OC additional output. It may control external device. 

Provides ground during activation. 
 

After careful connections examination a battery may be connected (to +/- AKU 

terminals of LX-ZAS power supply) and then power may be switched on for 
transformer and programming procedure of transmitter may begin (See Chapter 

6). 
 
 

3.2 PCB VERSION  

If the users chose the option to buy only the transmitter circuit they will have to 

provide power supply for the device. It should be connected using the following 
terminals  

 
+12 V Power supply’s positive end  
  

GND Power supply’s negative end  
 

  
 
THE FOLLOWING CONNECTIONS ARE PURPOSED FOR COOPERATION WITH LX-ZAS 

POWER SUPPLY. IF OTHER POWER SUPPLY APPLIED, INPUTS SHALL BE LEFT WITHOUT 

WIRING.  

 

BTT  
Control input for verification of battery connected to EBS 
power supply. 

  

PWR 
Control input connected to adequate EBS power supply 

output. Purposed for monitoring AC power supply. 
  

 
MANUFACTURER RESERVES THE RIGHT TO AMEND APPEARANCE OF PRINTED CIRCUIT 

WITH NO EFFECT ON FUNCTIONALITY OF DEVICE. 
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3.3 LX-ZAS POWER SUPPLY 

The dedicated power supply LX-ZAS (product of EBS) possesses the following 

parameters:  
 

Parameter Value 

Served batteries Acid-leaded 12V 

Maximum voltage of charging battery 13.8V 

Charging current 
0.2A or 1A (switched by 

jumper) 

Voltage of signalling of low level 11 V 

Voltage of switch-off battery 9.5V 

 
as well as it characterizes with following proprieties: 
 

� protection against opposite connecting battery. 
protection against excessive unloading battery: The battery protects 

before damage in case of long-lasting fading the AC. In case of lack the 
AC and unloading below voltage 9.5 V the battery becomes separated 
from device automatically. 

� quick charging of the battery: 
The jumper showed on drawing place causes settlement of maximum 

current of charging on 1A. We recommended jumper be taken off and the 
current of charging battery carries out 0.2 A. 

 

 

 
Figure 3. Choice of current of charging the battery 

 
Note: the applying the quick charging can bring to damage of battery. 

 

� protection against opposite connecting battery. 
 

 
 
 
 
 
 
 
 
 

4 OPERATION  
 

jumper ON => charging 
current 1A 
 
jumper OFF => charging 
current 0,2A 
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A device maintains communication with the monitoring station via 
Ethernet/Internet network. 

If status of inputs is the same as programmed one (NO or NC) a device 
stays in a rest. Change of status on any input results in immediate signal 
transmitting of this event by the device.  

 
Note: 

Each device input (from IN1 till IN4) may be individually defined as on open one 
(NO) or closed one (NC). It means that when in NO, input shorting will be an 
active state and, a non-shorting will be an active state in NC. 

 
All inputs respond only to states change which means that transmitting will 

follow only if an active state is on input and maintains during programmed 
minimum time. Maintenance of active state longer than a minimum time will 
result in single indicating. Another input activation (another transmitting) is 

possible only after input reached based state. 
 

EX20 transmitter additionally is equipped with input of a PSTN telephone line, 
and input to connect telephone communicator module of alarm control panel. 

Module constantly controls availability of an external telephone line. Decrease 

of line voltage below around 5V is deemed as a line damage. If an exterior 
phone line is operating, it is provided for output of telephone communicator 

module. If damage of urban line follows, a module disconnects an urban line and 
provides a voltage simulating telephone line to output of telephone 
communicator module. Module always provides voltage corresponding to 

operating phone line for an alarm control panel (namely to phone communicator 
module) regardless of urban line status. 

Configuration of transmitter for cooperation with a control panel’s phone 
communicator requires entering into memory a phone number for which 

transmitter is to answer.  
Once a phone is picked up via an alarm control panel telephone 

communicator, a telephone number is being dialled to make connection. After 

the control panel dialled a number to which transmitter is to respond, a 
transmitter takes over a phone line namely disconnects an urban line from a 

control panel and provides to a phone communicator voltage that simulates an 
operating phone line. Next it generates confirmation signal and waits for data 
from a control panel –next DTMF tones generated with communicator are 

treated as data. After transmitting adequate number of DTMF signs (16 for 
ContactID and 9 for Ademco Express 4/2) a transmitter generates Kissoff signal. 

Collection of data from control panel finishes at hanging up a phone of a control 
panel by phone communicator module. After that transmitter comes back to 
standard operation –namely if urban line is operating, it is being connected to an 

alarm control panel and waits for dialling of new number. 
If telephone number dialled with communicator is other than number module 

answers, no operation follows and it waits until communicator hangs up a phone 
and picks it up again – since picking up a telephone number dialled with a 
communicator module is being checked. 

 
All programmable parameters are saved in memory and in case of voltage 

drop that are not lost. Supply of power starts the transmitter with saved 
settings. 
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5 CONFIGURATION PROGRAM  
 

5.1 INITIAL REMARKS 

 
The GPRS transmitters configurator (versions 1.1.709 and higher) allow to 

configure the EX20 Ethernet transmitter. For local parameters programming, 
firmware replacement and reading the events log the dedicated LX-PROG cable 

should be used. Monitoring of the devices should take place using a dedicated 
LX-DATA cable (not included). 

5.2 COMPUTER - REQUIREMENTS  

 
Minimum requirements for computer system where configuration software is to 

be installed: 
Hardware: 

o Processor Pentium II 400 MHz,  
o 64 MB RAM,  
o 1 GB HD. 

o CD-ROM, 
o RS-232 serial port 

o Colour monitor (minimum 15 inch , min. 800x600 resolution), 
o Keyboard  
o Mouse 

Software: 
o Operation system Windows 2000 or Windows XP 

o NET Framework 2.0 (delivered along with installation wizard of 
configuration). 

5.3 PROGRAM FUNCTIONS 

 
After installation and program starting a main view shall be displayed on 

screen. Thanks to this view an access to program or programmable 
parameters of device is possible (see chapter 6).  

Main window of program is divided into some fields.  
 
Main menu: at upper part of window, contains control and configuration 

options. 
 

 
 
Main menu contents: 
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Main menu is available as icons on fast access bar: 
 

 
 

5.3.1 File -> New 

 
Opens new set of parameters. Editing of configuration parameters is 
possible.  

 

 
 

5.3.2 File -> Open 
 

If file contains saved settings, they may be used to program next device. 

Firstly a catalogue where file has been saved shall be chosen and then 
name of file shall be provided. Obtained data collection may be modified by 
the user. Any amendments are effective if send to device. 

 
 

5.3.3 File -> Save 
 

During programming many devices in different configurations, it is not 
necessary to have in mind each one as it may be saved on hard disc or 

floppy disk under any name and it may be loaded later on. This function 
saves on disc any information from configuration wizard window. After 

activation of function a dialog window appears with request to provide file 
name. Default data is saved with CMI extension (Configuration Memory 
Image). 

 
5.3.4 File -> Language 

Allows for selection of any available languages (determined in attached 
exterior language files). 
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5.3.5 File -> Connections 
Before programming of devices, a connection type shall be defined. It is 
possible to do it with two methods: - locally, - remotely 

 

5.3.5.1 Local connection 

Local connection means that configuration software (namely computer on 

which is installed) is directly connected to proper terminal of transmitter. 
Connection is possible owing to special wire and through RS-232 serial port. 

To program device or make any other operations (e.g. reading of device 
settings, firmware amendments, etc.) it is necessary firstly to define 
connection parameters. 

 
It is possible to do so with the above window that is available after 

activation of connection from Main Menu and selection Configuration tab or 

after clicking on  icon on fast access bar and clicking on  

 

 
 
 
 

 
RS232 tab 

 
Define: 

Name of connection e.g. Locally 
Choose serial port e.g. COM 4 
 

Click on [Add] button to confirm settings. Connections shall be saved (and 
inserted in table). From this time on program shall enable wires 



EX20-Manual_EN_1.11w3.doc  Strona 13 /36 

connection with device and reading, and saving of parameters in memory 
will be possible. 

 
5.3.5.2 Remote connection 

The device and software makes for complete configuration with GPRS link 
or CSD channel. This programming mode requires definition of linking 

parameters. 
 

GPRS 

 
The GPRS tab allows for configuration of link with the device via 

OSM.2007 server. 
 

 
 

Define: 

� ( Name of connection e.g.: Remote 
� ( Select name of analyzer e.g.: Primary 

� ( Enter analyzer address e.g.: www.ebs.pl 
� ( Enter port on which analyzer operates e.g. 9000 
 

Click [Add] button to confirm settings and save connection (settings are 
inserted into table). Since that time a remote connection to device, 

reading and saving of parameters in memory is possible. 
 

Notice: The following parameters: analyzer name, analyze 
address, port relate to settings of OSM.2007 receiver of 
monitoring system. Remote programming is available only if 

above mentioned device (or software) is used. 
 

5.3.6 6.3.6.File-> Archiving 
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All configurator settings, both those read from devices and saved into 
devices, are automatically saved on hard disk. If the catalogues were not 

found during installation of configurator, the files can be found e.g. at: 
C:\Program Files\EBS\KonfiguratorLX\configs\LX10_20000 
The LX10_20000 catalogue contains all files connected with programming 

the LX10 device with factory number 20000. Their names contain date and 
time of operation, as well as its type (writing / reading). The files’ extension 

is cmi.  
 

5.3.7 File -> Exit 
 

Finishes the programme operation. 
 

5.3.8 Operations -> Read 
 

The function reads out data saved in the module’s memory. The data 
exchange takes place via the port selected in “Select connection type” 

section (see the description of “Configuration” option below). Correct 
readout is confirmed with appropriate massage. The data read from the 

device may be saved to a file (see point.5.3.3), and then use in other 
devices. 
This function requires defining of the type and parameters of connection. 

For example, for the local connection the following view is displayed: 
 

 
Where: 
 
Port – serial port to which module is connected. 

Access code– service code of transmitter 
 

Detailed description of connections configuration is included in clause 5.3.5. 
 
5.3.9 Operations -> Send 

 
This function is analogical to the above one, at the same time it enables 
data saving into EEPROM module. Correct saving is confirmed with message 

on a screen.  
 

5.3.10 Operation -> Restore default settings 
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If operation “Read” finishes with error message (e.g. if access code is 
unknown) it is possible to come back to default settings by selecting 

“Restore default settings”. e “Do you want to overwrite current 
configuration with default values?”. After confirming the following window 
shall appear: 

 
 
This operation is possible only with local connection. After operation 

completing device parameters shall come back to default settings. 
 
5.3.11 Help -> About program 

 
This option presents additional information about the programme. 

 

 
 

6 PROGRAMMABLE PARAMETERS  
 
Parameters available in configuration program are divided into three groups. Each 

of these groups will be described in detail in next part of this manual. 
 

6.1 ACCESS 
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6.1.1 Transmitter’s network parameters 

6.1.1.1 IP 

 
Depending on the device’s network configuration the user may chose from 

the following operation modes: 
► IP assigned by DHCP server,  
► Static IP 

 
If the operation mode with static IP is selected, the user should provide the 

basic network parameters of the transmitter: 
o Address 
o Mask 

o Gate 
 

6.1.2 Parameter 

 
6.1.2.1 Test sending time 

 
The device sends signal “Test” with determined interval that informs 
monitoring station that the device is in operation mode. In this field you 

can determine how often this message will be sent (in seconds).  
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6.1.3 Main Server Parameters 

6.1.3.1 IP server address 

 
It is address of receiver of monitoring system (OSM.2007) or computer 
where “Communication Server” software has been installed, e.g. 
89.123.115.8. 

 

6.1.3.2 Server port 

 
It determines server port that was selected in server for collection of 
data from transmitter.  

 

6.1.3.3 Interval between subsequent connection 

 
Programmable device will try to make automatic connection with server. 
In this field you define interval (in seconds) after which next connection 

will follow if the previous connection failed.  
 

6.1.3.4 Number of connection attempts 
 

In this filed you determine how many times device will try to make 
connection to server. If connections fail, the transmitter after execution 

of some connection will start procedure of connection to back up server. 
This option is active only if we define parameters of backup server. 

 

6.1.3.5 Order of connection to servers 
 

Mark this check box means, that the device will try in first order to 

connect to primary server, without regard on definition of parameters 
for backup server (in peculiarity of number of connection attempts). 

6.1.4 Backup server parameters 

6.1.4.1 IP server address 

 
It is address of the second (reserve) receiver of monitoring system 

(OSM.2007) or computer where “Communication Server” software has 
been installed, e.g. 89.130.125.82. 
 

6.1.4.2 Server port 

 

It determines server port that was selected in server for collection of 
data from transmitter.  

 

6.1.4.3 Interval between subsequent connection 
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If device can not connect to primary server defined this after exhaustion 
for him number of attempts, it will begin realizing the procedure of 

connecting to backup server. We in this place define space of time (in 
seconds), after which test will connecting renewed if previous finished 
with failure.  

 
6.1.4.4 Number of connection attempts 

 
In this field you determine how often device will try to make connection 
to backup server. If connections fail, transmitter after execution of some 
connection will back to procedure of connection to primary server. 

 
6.1.4.5 Disconnect after time limit 

 
If you mark this choice field the device will disconnect from back up 
server after passage of set time. Further operation depends on defined 
parameter Order of connection (See clause 6.1.3.5). If this option is 

active the device reconnects to the primary server. If this option is not 
active the device firstly completes connection to backup server 

procedure and if this fails, the device will try to connect to the primary 
server. 

6.1.5 Access 

6.1.5.1 Administrator’s service code 

 
It provides security against unauthorized access. Allows for access to all 

configurable transmitter’s options. Factory setting is 1111. During the 
first starting of device (programming) it shall be changed. Code may 
consist of up to seven alpha numerical characters. 

 

6.1.5.2 Installer’s service code 

 
Allows for limiting the installer’s access solely to the configurable 
parameters in “Monitoring”, “Inputs/Outputs” and “Firmware” tabs. 
Factory setting is 2222. During the first starting of device 

(programming) it shall be changed. Code may consist of up to seven 
alpha numerical characters. 

 

6.2 TRANSMISSION 

For the purpose of maximum security of transmission, data is encrypted with 

AES key. The device also allows for entering user’s own encryption key (256 
bits – characters 0-9 and A-F). The option with default key parameters is 
activated by default. 
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6.3 INPUTS/OUTPUTS 

Transmitter has got 4 signal inputs and additional input for sabotage signal 

switch-key connection. Module is equipped with two outputs: indicating 
sabotage and an additional one. In/Out option enable programmable 

configuration so that transmitter operates pursuant to requirements of the 
user.  
All inputs of the device are 24 hour alarm inputs. 

 
 

6.3.1 Inputs 

For every input the following settings shall be determined respectively. 

 
6.3.1.1 NO/NC  

This parameter allow for setting of constant input. Change of this state 
results in sending information on alarm. Allowable NC and NO input. NC input 

shall be shorted to ground. Actuation follows after decay. NO input remains 
open. At this moment of shortening to ground activation follows. 
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6.3.1.2 Delay [ms]   

This parameter means minimum time for change maintenance at input so 
that it would be detected by transmitter. Factory setting is 400ms. 
 

6.3.1.3 Lock 
 
With this option you can lock any input of module, and as a result condition 

changes on this input will be ignored and will not be reported to monitoring 
station. Lock may be persistent or temporary. 

In case of temporary lock – user can set lock time and number of input 

state changes after which lock occurs. Lock time is counted from first input 
state change. More detailed information about input locks is shown on a 

diagram. 
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Limit:  count N = 3 in time Tb

Tb Tb Tb Tb Tb

Input triger and restore

Temporary locked input triger and restore – no transmition

Locked input

Events sent to the server

Event: input triger

Event: input restore

Event: automatic input lock

Event: automatic input unlock

- It is possible to sent 2 x N – 1 during Tb. Statically for long period a device sents max N events in Tb.

- For all inputs parameters N and Tb are configurable

- Atomatic lock is engage after restor

 
 

Temporary lock may be deactivated by a command sent via OSM.2007 server 
(RLIMIT command)  

 
The user may permanently block a given input checking a Permanent field 
corresponding to a given input. 

 
Permanent lock may be activated and deactivated via OSM.2007 server.  

 
 

6.3.2 Output 1 / Output 2 
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6.3.2.1 Active output mode and time 

Thanks to this option you may choose output operation mode. There are two 
operation modes available: 

o Bistable– connection follows for indefinite time- up to the moment of 
disconnection of power for module,  

o Monostable– connection follows for time defined by user - every 

100ms. 
 

6.3.2.2 Conditions 
 
Additionally describe other events to result in activation of inputs There are 

two options available: 
 

a) When connection with the server is lost (directly upon detection) 
 
b) Upon change of state of one of the inputs from non-active to active 

 
 

There are two options available:  
 

o Never: input disturbance does not cause operation of sabotage 

output,  
o No network: input disturbance causes actuation of sabotage output if 

sending of information to server is impossible. 
o Always: every input disturbance causes actuation of sabotage output.  
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o Available network: input disturbance causes actuation of sabotage 
output if sending of information to server is possible. 

 
 

6.4 MONITORING 

Thanks to this option you may determine which of available signals generated 

by the device shall be transmitted to monitoring station.  
 

 
 

6.4.1 Turning on/off 

In this part you define signals that may be reported at monitoring station. 
There is possibility to send information on alarms (input state change from rest 

to action status) and on returns of input state from action to rest 
(normalization). 

To transmit any signal you should only click it (proper square on your right).  
Click on [Clear] button to remove all marked signals. 
Click on [Invert] button to change markings to contrary. 

 
6.4.2 Skip initial state 

This option allow for locking of sending of information on status of active 
inputs at power connection. Information on inputs will be sent to server after 

the first change from inactive to active status. 
 

6.4.3 Power loss 



EX20-Manual_EN_1.11w3.doc  Strona 24 /36 

One of device additional options is monitoring of power supply voltage. As 
short voltage drop may follows at some facilities, it is possible to avoid 

reporting by entering time after which information will be sent. One of device 
additional options is monitoring of power supply voltage. As short voltage drop 
may follows at some facilities, it is possible to avoid reporting by entering time 

after which information will be sent.  
 

 

6.5 LINK CONTROL 

 
 
These options enable automatic action of device if communication with 

monitoring station was broken up. 
 

Activate this function (mark [Turn On] field) to get access to parameters 

determining action of device. 
Define time limit after which transmitter shall reconnect to network. Enter time 

limit in field [Reset after] and provide this value in minutes. 
 
Next define action that the device shall perform. Select action by marking 

proper square next action description: 
o Ethernet module reset 

o Device Reset 
o Turn on Output 1 
o Turn on Output 2 
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In case of no connection with the server, the device after recognizing the 
situation shall wait during provided time limit and then shall perform 

programmed actions. 
 
 

6.6 RS232 

 
 
 

6.6.1 Serial port settings 

The device has been equipped with RS-232 serial port to enable obtaining 
additional information. To make use of this link it is required to define its 

parameters. For this purpose select parameters from the below table:  
 

Parameter Value 

Baud rate (bits/sec) 300, 1200, 2400, 4800, 9600, 19200, 38400, 
57600, 115200 

Data bits 5, 6, 7, 8 

Parity None, even, odd, mark, space 

Stop bits 1, 2 

Flow control None, RTS, CTS, RTS/CTS 

 

The selected parameters shall correspond to RS-232 port settings in device, with 
which the transmitter is to cooperate.  
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6.6.2 Buffer flushing 

 

Data received from connected device are stored in transmitter buffer. Buffer 
capacity is 511 bytes. Define criteria that meeting shall mean data transmission 
to monitoring system transmitter. The following options are available: 

� - After receiving ASCII character 
� - After expiry of defined time 

� - After receiving defined amount of characters 
 

For every option list of available values are provided, and they me be scrolled 

down after clicking on adequate arrow. 
 

The transmitter controls buffer contents in respect of meeting of determined 
criteria. It is performed with the following order: selected character, time, 
number of characters.   

 

6.6.3 Advanced port options 

6.6.3.1 Disable data receiving 

 
This option allow for lock of data received from device connected to RS-232 
port of transmitter. It is used in case of failure or situation when EX20 is being 
used to control the device.  

 

6.6.3.2 Disable data sending 

 
This option allow for lock of data sending to device connected to RS-232 port 
of transmitter. This prevents accidental or unauthorized controlling of the 
device. 

6.6.3.3 Half Duplex mode 

 
This option provides for automatic lock of data receiving (via RTS) if 

transmitter begin to send data to the device. 

6.6.3.4 Tests of device connection to port 

 
If the device connected to transmitter port generates periodical connection 

tests, these tests may be under EX20 control. To provide for that (after this 
option activation) enter text message and define frequency (in “Test presence 

every [s]” option). 
Additionally user may determine if text messages will be sent to server. If 

this option was not selected it is required to make sure that while the device 

connected to transmitter port is not sending text message to transmitter, EX20 
sends to server due message (See chapter 6.4 Tests RS232).  

 
 

6.7 PHONE LINE 
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The device is equipped with an external, city telephone line. It may be used to 
transmit data from an alarm control panel. Additionally transmitter may collect 

information from a control panel using its phone communicator, and next 
transmit them to the server via Ethernet. The mentioned below parameters shall 
be defined for proper operation of the device.  

 
6.7.1 Phone line 

This tab is provided to determine settings of telephone line. 
 

 

6.7.1.1 External phone line 

 
If this function has been chosen (Activation) the transmitter will be 

cooperating with PSTN line. This way data transmission is possible from an 
alarm control panel with two ways: via Ethernet and standard telephone line. 

 

6.7.1.2 Monitor external phone line voltage 

 
If transmission with two ways follows, it is necessary that operator of 

monitoring system received information on access to an external telephone 
line. Choice of this option will result in voltage drop on telephone line (longer 

that defined minimal time of decay) that will be signalized with an adequate 
message sent via Ethernet. 

 

Note: The transmitter is to simulate a telephone line access if:   
o A PSTN line is not connected  
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o A PSTN line is connected but has not been activated –option from 
clause 6.7.1.1 

o Options from clause 6.7.1.1 and clause 6.7.1.2 are active and 
voltage on terminals TIP–RING decreased below 8V. 

 

6.7.1.3 Report off-hook condition 

 
If a phone set is connected in parallel output of control panel communicator 

(to terminals T1-R1 of transmitter), picking up of a phone prevent from 
exchange of data between a control panel and a transmitter. There is 
possibility to control this situation. Choice of this option result in sending a 

report to monitoring station if time of picking up the phone exceeds 
determined time limit. 

6.7.1.4 Report “intervals too long” 

 
This option is being used if in configuration PSTN line– EX20- Alarm Control 
Panel there are not other telecommunication devices. If such device will be 

connected and telephone number will be dialled (and a call will follow) after 
expiry defined time limit (counted since conclusion of last digit dialling) the 

transmitter sends a message. This operation prevents unauthorised 
installation of additional devices.  

6.7.1.5 Generate dial tone 

 
Some alarm control panels require that during a receiver picking up a tone of 
dialling was actuated. To enable cooperation with a transmitter it is possible 

to make a transmitter to generate such tone. 
 

6.7.2 First and Second phone number 

 
To provide for proper cooperation between a transmitter and a control panel in 

DTMF mode determination of some parameters is required. The below 
described functions are analogous to the both telephone numbers that may be 
saved in the device memory. 
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6.7.2.1 DTMF phone number 

 
This is a number that has been saved in memory of an alarm control panel. If 
the panel is to transmit information on an event it shall dialled this number. 

Transmission of this information via Ethernet will be possible if this number 
will be identical as a number entered into the transmitter. 

6.7.2.2 Handshake delay 

 
This defines time after which a transmitter generates confirmation to an 
alarm control panel for correct phone number dial. Default setting is 2.0 sec. 

European Standard determines this value at 0.5 to 12.5 sec. 

6.7.2.3 Protocol 

 
Select protocol of data transmission used by an alarm control panel and that 

is acceptable for monitoring station. Available options: ContactID, Ademco 
Fast, and DTMF. 

 
Note:  
1) [Disable CRC checking] option may be used for ContactID and Ademco 

formats. Some control panel generate improper messages regarding a 
control sum for transmitted data, the device is not able to confirm collection 

of data, and as a result the panel tries to send them again (until execution 
of all determined trials). Select this option to avoid the above mentioned. 
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2) In case of DTMF protocol we gain access to specific parameters used to 
generate some control signals. 

 

6.8 FIRMWARE 

The device is equipped with built in bootloader that allow for updating and 
change of firmware. During programming all information is displayed in respect 

of carried out operation.  
 

 
 
Follow the following procedure:  

a) Launch configuration program 
b) Open “Firmware” option of configuration wizard 
c) Open file with new firmware (click [Open] button to locate where file is). 

d) Select file transmission mode: local or remote. 
Note: Procedure of assigning firmware to a device is analogous to 

programming a device. For procedure refer to chapter 7. 
e) Click [Start] button to start software exchange. 
f) Loading course is displayed on special window.  

g) Close the window after completed saving  
 

From this time on the device will work under control of new firmware. 
 

Note: The above procedure shall be carried out with due care to avoid 

improper device operation. 
 

 

6.9 DEVICE MONITOR 
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“Device Monitor” provides real-time information about device state. To use this 
function device must be connected to PC computer with LX-DATA cable (using 

DEBUG plug). Correct RS232 port must be chosen in “Port” field. “Device 
monitor” provides following information: 

• AC and battery power indication 

• PSTN line indication 
• Correct network connection 

• Inputs state monitoring 
• Outputs state monitoring 
• Type or serial number of device 

• Firmware and hardware revision 
• Device time 

Changes to all parameters are also shown as text in LOG window 
 

6.10 EVENTS HISTORY 
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The function allows to read the recent events recorded in the device’s memory The 
memory may store about 5 thousand recent events In order to read it, the EX20 

should be connected to a PC using LX-PROG cable The user should then select 
appropriate RS232 port in the „Events history” window, enter the installer’s code 

and click ”Read” 
 

7 DEVICE PROGRAMMING 

Programming of device is possible with “GPRS transmitter’s configurator” 
configuration program described in chapter 5. To program the device establish 

connection with a device. Depending on connection mode there are two ways for 
programming. 

 

7.1 LOCAL PROGRAMMING. 

To program a device locally follow the procedure: 
 

a) Connect PROG joint (on printed circuit) with COM computer port by way of    
service wire, defined in option -> RS-232  

 
b) Connect power supply to terminals +12V and GND. After connection and 

detection of programming wire a module shall signal this with LED diodes: 

a green one shall flash and red one shall flicker. 
 

 
c) Launch software and define device options. Provide right servicing code.  
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d) Save settings into memory of device. Saving course is displayed in special 

window.  
 

 

e) After saving disconnect power supply and disassembly service wire.  
 

 
f) Connect module wiring pursuant to guidelines from chapter 4. Turn power 

supply on. 

 
 

g) The device is ready to transmit data. 
 
 

 

7.2 REMOTE PROGRAMMING 

Remote programming of device is possible if user uses OSM.2007 monitoring 

system receiver.  
 

According to description in chapter 6.3.5.2, it is required to define remote link 
on grounds of OSM.2007 parameters. As OSM.2007 collects (and transmits) 
information exclusively from devices saved in data base, the first operation 

during remote programming is proper registration of the device. This procedure 
has been described in OSM.2007 Operation Manual.2007. 

 

8 LED DIODES INDICATION 

Four LED diodes mounted directly on the main circuit, and two LED diodes on 
the Tibbo Ethernet module, are purposed to show actual condition of the device. 

 

8.1 PROGRAMMING 

After detection of programming wire diodes indicate programming. 
LED diodes of the main circuit 

 

Description 

Green Red 

 

Connected 

Service 

wire 

 

       

 
        

 

 

 

 
 

Programming 

in CSD mode 
 

  
 

8.2 RECEIVING OF DTMF DATA 
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Yellow diodes marked as STATUS and a yellow one marked as DTMF indicate 
actual condition during receiving data from a control panel.  

 
LED diodes of the 

main circuit 

Signalling 

STATUS (yellow) 

 

 

 
 

 
DTMF (blue) 

 

                         
                      (HandShake)                                                   (KissOff) 

 

 
        

6 digits of phone                                  16 digits ContactID                         

8.3 FIRMWARE UPDATING 

During programming bootloader operating is indicated. If error follows during 
updating there is bootloader in device and another programming of device is 

possible. 
 

LED diodes of the main circuit 

 

Description 

Green Red 

 

 

No program in 

device 

 

       

 

 
        

(1/sek) 

 

 

 

 

 

(constant light) 

 

Software updating 

 

 

 

 

Received firmware 

decoding 

10 sec 
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8.4 CORRECT NETWORK CABLE CONNECTION 

Correct EX20 connection to the Ethernet/Internet network is signalled by a 
green LED diode of the Ethernet Tibbo module going on with constant light. 

 
LED diode Signalling 

(green) 

 

 

 
* each short decline in brightness of the LED diode signals reception of a 

package 

 

8.5 NO NETWORK CABLE 

Damage to or lack of network cable is also signalled by the green LED diode of 

the Ethernet Tibbo module 
 

LED diode Signalling 

(green) 

 

 

 

 

 

8.6 10MB /100MB NETWORK STANDARD 

The Tibbo Ethernet module detects the present network standard and signals its 
type using the yellow LED diode. 
 
Network 
standard 

LED diode Signalling 

10Mb 

 

 (yellow) 

 

 

 

 
 

(off) 

100Mb (yellow) 

 

 

 

 
 

(constant light) 

 
 
 

2 sec 
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9 CHANGELOG 

 
Date/Version Description 

14.09.2009 English version 

07.07.2009 First version of the manual 

04.08.2009 Revision; some configurator’s tabs views updated to version 
1.1.716 

 


